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OVERVIEW \

Congratulations on your purchase of Jiose Printer. Jiose is your
loyal business partner offering commercial solutions to batch
label printing.

Please take a moment to follow this user guide, as incorrect
operation may result in unsatisfactory print quality, a poorer user
experience, or even damage to your printer or injury.

aEEEER Highly Recommended: Watch the
Quick Setup Video!

In the USB drive included with this label printer,
there are short videos. It will guide you on how
to set up the printer in a way that best suits your
L 11111 needs. You may also visit our website
wwwi.jioseprinter.com, which offers FAQs, live
chat, and phone calls to help solve some
problems quickly.




PACKAGE CONTENTS \

Check that the package contains the following items before
using the label printer. If any item is missing or damaged,
please contact us.

Label Printer Fan-fold Labels User Manual

= =

Power Adapter USB Cable  USBDrive  USB Type-C
Adapter

» Note

Installation drivers and setup guides for Windows/MacOS
can be downloaded from the Jiose official website or found
on the provided Jiose USB drive.




MACHINE COMPONENTS \

- Inner View Printer Head
Mechanism

Paper Feeding
Guide Rail

» How-to Open:

Press the both Push Buttons on the side at the same time to
open the printer.

- Rear View

Feed Button Paper Feeding
Guide Rail

SB Port
Push Button

Power Button



PRINTER CONNECTION \

(V] (X » Warning

Make sure the printer is OFF (O=OFF)
before plugging in the power cable.
OFF ON Otherwise, it will affect the service life.

1. Ensure the printer poweris 2. Connect the power cable
OFF (O=O FF) (Make sure your adapter is connected

to the power cable tightly.)

_ —

3. Connect the USB cable 4. Turn the power ON (I=ON)
(If your computer has only Type-C
interface, please use a Type-C USB
cable or USB-C to USB Adapter.)




LED LIGHT INDICATOR \

Light Description Troubleshoot

Solid Blue Normal operation

: : The printer job will

, Printer head is ;

Flashing Blue overheated l(’:eosgllmgl itself after
Flashing Red Reload label to
(once per Paper shortage check if label is
second) loaded correctly.
Flashing Red .
(twice every Lid is not closed Close the lid properly.
second)
Solid Purple Firmware upgrade Restart the printer to
(or white) mode restore normal.

Flashing Purple
(or White) with
beeps

Wrong power
adapter

Use original power
adapter or contact
customer service.




LABEL SETUP ‘

Label Standard Size

L] [ ]
3"Xl" 2X1”
37X2" 2"X2"

33"

47X4"

4"X6"

1.Automatic Label Identification
(Load label without opening the printer)

(1 Connect the printer to the power and turn it on,

(2) Adjust the guide rail (refer to picture a).

() Insert the label deeply and straightly along the guide rail with no
gaps or deviations (refer to picture b).

(@) Once the printer detects the label, it will automatically catch the
label and roll it back and forth. When finished, the label will be
positioned at the tear-off point.




LABEL SETUP ‘

2. Run the Intelligent Label Study

@ After the Automatic Label Identification, press the Feed Button
until you hear one beep, then release it (refer to picture c)

@ The printer will move the label back and forth at the previous 2
joints of the label, to study the label size, thickness, and gap size of
your label (refer to picture d).

(3 After studying the label, the printer will be positioned at the tear-off
point so that not a single sheet of paper is wasted.

@ Then the printing can begin.

» Note

When loading the printer with labels of different sizes, please run the
Intelligent Label Study process before printing.




FEED BUTTON MODE \

Desired Action

Execution

Run the Intelligent
Label Study

Insert label, press and hold the Feed Button
until hearing one "beep" sound.

#% Each time you change your label, run the
Intelligent Label Study process.

Print a technical

Load the paper, press and hold the Feed
Button until you hear a sequence of two

test page beep sounds (one short "beep" followed by
"beep beep").
Press and hold the Feed Button until you
Restore factory | hear three beep sounds. (a single "beep,
setting followed by "beep beep", and concluding
with "beep beep beep")
Skip a label One Click the Feed Button while the printer

is on standby. (i.e. nothing is being printed)

Pause printing

One Click the Feed Button while printing
many sheets.

Resume printing

One Click the Feed Button again to resume
printing from a pause.




DRIVER INSTALLATION
FOR MACOS & WINDOWS

Thermal Label Printer Driver Installation for Windows

The following is a picture example of the installation steps of the thermal
printer J500/J5008BT.
. Insert the USB drive that came with the package to computer.

Il. Open the Windows Driver folder to get the driver file and install it with
the following steps (or visit website: wwwjioseprintercom to get it).

-

» Note
Make sure the label printer is connected to your computer
with the USB cable and turn it ON (I=ON) before installation.




01. Double click the Windows driver file to install it.

ﬁ\_ 1500 Driver Installation Guide for Windows.pdf

@ J500 Printing Setup Guide for Windows.pdf
J Jiose-Windows-Driver-Latest v1.2.1.exe ‘

02. Click "Yes" to allow the installation.

J Jiose Printer Driver Setup

Verified publisher: HONGKONG JIAHE INTERNATIONAL HOLDING
LIMITED
File origin: Hard drive on this computer

Show more details
g

J Setup - Jiose-Windows-Driver-Latest v1.3.2 = o

Ready to Install
Setup is now ready to begin instaling Jose-Windows-Driver-Latest v1.3.2 on
Your computer.

Click Install to continue with the instalation.

Engish




03. Then, it will show as below, (The Port should be automatically filled out
by USB001 or USB002, USB003,...). Click the "Install Driver Now" as the
arrow pointed.

Printer Model: ~Jiose J500 ~

Driver Name:  Jiose J500 8 Default Printer

Detect USB Port

Port:

Tips: if program can't find
button to get current USB'

Automatically filled out

Port

USBOOT Virtual printer port for USB
USBO002 Virtual printer port for USB
USB003 Virtual printer port for USB
USBOO4 Virtual printer port for USB
USBO0S Virtual printer port for USB
USBO06 Virtual printer port for USB
USBO07 Virtual printer port for USB
USBO08 Virtual printer port for USB

Install Driver Now! Exit

Detected USB Port : USB009 ‘

04. Finally, the page will display "Add Printer Successfully!"
(Tips: If you do not see the successful dialog box, please proceed
with the following troubleshooting steps.)




05. OK, the driver installation has been completed if you see the "Add Printer
Successfully!" dialog. You may close the dialog now and try to print a sample
shipping label.

Otherwise, you may need to follow the troubleshooting steps to install the
printer properly.

» Note

If the printer is not connected to the computer and power on, the driver
wizard will be unable to detect the port. In addition, it will display a error
message with tips when you click "Install Driver Now".

Printer Model: Jiose J500 7
Driver Name: | | Default Printer

Port: | | Detect USB Port
Tips:ifpr | PS “ button
togetcu

Please select port,or click [Detect USB Port] button when you power on

printer

OK
Install Driver Now! Exit

Please select port




At this point, connect the printer to your computer using the USB cable
and turn it on.

Then, click "Detect USB Port" again and the USB port should be able to
detected normally. You can click the “Install Driver Now!" button now to
install the printer.

Port:  |USBOOT Detact USB Port

Tips: if program can't find L

e

e click [Detect USB Port]

button to get current USB g Tips X ler port in the list below.
~

part Add Printer Successfully! Type
SHRFAX: & Monitor Port
COM1: Local Port
COM2: Local Port ‘
COM3: Local Port
COM4: Local Port
FILE: Local Port
LPT1: Local Port
LPT2: Local Port 4
< >

Install Driver Now!

(il oy dre

Click it to continue the

installation

» Tips
The driver is designed to be compatible with different versions of
Windows system currently available in the market (Win 7 or newer). The
installation process should be simple, similar to installing other softwares.
If you encounter any challenges and need assistance, feel free to reach
out to our customer service for guidance.




Thermal Label Printer Driver Installation for Mac

The following is a picture example of the installation steps of the thermal
printer J500/J500BT.
|. MacOS Driver installation

01. Insert the USB drive that came with the package to computer.

[

02. Open the MacOS Driver folder to get the driver file and install it
with the following steps (or visit website: www.jioseprinter.com to get it).

» Note

Before installation, make sure that the label printer is connected to
your computer with the USB cable and power on. This will allow the
driver wizard to automatically identify the printer model.




03. Double-click on the *dmg driver file to open the file.

Jiose-Mac- ‘
Driver_v1.2.4.dmg R

04. It will show as below. Double-click on the *.pkg file to run the
installation wizard.

(. [ ] J Jiose-Mac-Driver_v1.2.4
J I
Double Click
1 Read Instatlation Guide PDF 2. JiosePrinter-Driver.pkg’ to install 3 Print Sample to test
b o |
J500 Driver Installation JiosePrinter-Driver.pkg -
Guide for MacOS.pdf Sample.pdf
Get help: www.JiosePrinter.com




» Note

It may display a message that the file :
can't be opened because of security Pf
settings. Don't worry, you just need to
perform the following steps to grant can't be opened because it was

access.

(Tips: You can skip this step if you don't see this Your securtysetings alow nstalton
message or if you already know how to install a
third-party software on MacOS and prefer to do it

in your own way.)

)

?

“Jiose-Mac-Driver-v1.4.0.pkg"

not downloaded from the App
Store.

of only apps from the App Store.

OK

- @@

@. Open "System Preferences" on Mac from the Apple menu.

@. Click the "Privacy & Security" tab as the arrow pointed. Then scoll down
to find "Security", select "APP Store and identified developers" Then try

again to install the driver.

(o ° Privacy & Security )
Q
9 Focus App Management
8 seeen e B evomrion
() General
i [@ Analytics & improvements
Accessitilty ) Apple Advertising
£ control Center
© sii & spotiight ey
W Privacy & Security.
Allow applications downloaded from
(B pesktop & Dock App Store.
© App Store and identified developers
3 Displays -
{2 Wallpaper Q FileVault Turn Off..
FleVaut secures the gt
5 screen Saver
O sattery
) Lock screen
@ Touch ID & Password FlVaul s urned on for the sk *Macintosh HD".
Y Users & Groups
Turn On..
Passwords
L ‘ %

» Note

As MacOS updates its security policies periodically, if you are using
an older version of MacOS, or encounter other difficulties, please
contact our customer service for assistance.




05. Double-click on the *pkg file to start the installation wizard, then click
"Continue" and follow the onscreen instructions.

(‘ ‘@ Install JiosePrinter Ver1.2.4 B\

Welcome to the JiosePrinter Ver1.2.4 Installer

The driver files will be copied to the path: /Library/Printers/Jiose/
® Introduction

Continu
g — Y

[ ] @ Install JiosePrinter Ver1.2.4 a
Standard Install on “Macintosh HD"

Introduction This will take 101 KB of space on your computer.

Destination Select Click Install to perform a standard installation of this software
® Installation Type on the disk “Macintosh HD".

Change Install Location...

Customize Go Back Install ‘




06. Please grant authorization with account password, depending on your
Mac's security Settings.

~
a
st L
LL!_ 5
Introduction e
Destination Select isalen on of this software
o Installation Type Installer is trying to install new software.
Enter your password to allow this.
Jiose
Install Software
Cancel
Change Install Location...
Customize Go Back Install

Finally, it shows the driver is installed successfully. Please click "Close" to
finish the installation.

® @ Install JiosePrinter Ver1.2.4 8

The i ion was

Introduction

© Destination Select
Installation Type

Installation

S Summary The installation was successful.

The software was installed.

Close

At this moment, the driver has been installed. In addition, you still need to
add the printer to your Mac.



Il. Add the Label Printer

01. Select "System Preferences" and open it.

02. Select "Printers & Scanners" as the arrow pointed, then click "Add
Printer",

(. ® Printers & Scanners h
Cuiseaich Default printer Last Printer Used ¢
{5 control Center
© siri & spotiight
[ Privacy & Security No Printers

Default paper size Y

Desktop & Dock Add Printer, Scanner, or Fax...  ?
£ isplays

) Wallpaper
(22 screen Saver

& Battery

B Lock Screen
@ Touch ID & Password
8 users & Groups

click it to add a new printer.

L] Passwords
Internet Accounts
@ Game Center

(=) Keyboard
) Trackpad

% Printers & Scanners
K— v

» Note

Before adding printer, make sure that the printer is connected to
your computer with the USB cable and turned on. This will allow
the driver wizard to automatically identify the printer model.




03. The JIOSE J500 will appear automatically, just click on it to continue.
It will show as below. (If the printer is not listed here, check if the printer
is connected to the computer and turned on.)

moe

~

Add Printer

® ® @

(al

Name

JIOSE J500 ‘

Name: =
eoe Add Printer ™\
Location:
Use: @ @
” Q
\ Name ~ Kind
JIOSE J500 USB
Name: JIOSE J500
Location: Jiose's MacBook Air
Use: Choose a Driver... ‘
Software for this printer isn't availa. le from Apple. Contact the printer's
manufacturer for the latest software.

~  Kind




05. Then, click the "Select Software" in the "Use" drop-down box.

ED

Qe

Add Printer

® ® @

~

Name
JIOSE J500

Name: JIOSE J500

Location: Jiose’s MacBook Air

Use v Choose a Driver |

Auto Select
|
Select Software...

Other...

7

4

06. Select the "Jiose Label Printer" and click "OK" to continue.

to your comp

Add Printer

Printer Software

Q

Q Seal | DYMO Label Printer
Epson 24-Pin Series

Epson 9-Pin Series

HP DeskJet Series

HP LaserJet Series PCL 4/5
Intellitech IntelliBar Label Printer, 2.3
Oki 24-Pin Series

Oki 9-Pin Series

Zebra CPCL Label Printer
Zebra EPL1 Label Printer
Zebra EPL2 Label Printer

th the USB cable and power P

incel

Name
JIOSE U

uter wi
Locati

——— g ]

Use:  Select Software...




07. Click "Add", and the JIOSE J500 printer is added to your computer
successfully.

(ece Add Printer B\

@ ® @

Name ~ Kind
JIOSE J500

Name: JIOSE J500

Location: Jiose's MacBook Air

Use: Jiose Label printer ()

? Add f
-

08. Ok, the driver installation has been completed. You may now close
the window and learn how to set the parameters for your most commonly
used settings or try printing a sample shipping label.

(o ° Printers & Scanners R
Q Sesrch Default printer Last Printer Used &
© s spotignt Default paper size I
(O Privacy & security
(B peskiop & Dock Frire:
B pisplays L JIOSE J500
e, Laat

(. Wallpaper
&5 screen saver

2 Battery

(B Lock screen
@ Touch ID & Password
8 users & Groups

Add Printer, Scanner or Fax...  ?

{3 Passwords
nterne Accney
@ Game Center

B Wallet & Apple Pay

(L) Keyboard
) Trackpad

\E J




ChromeOS Installation

1. Go to Chrome Web Store, search for "Flashlabel Extension".

(https://chrome.goole.com/webstore/category/extensions)

e0e M Extensions X @& ChromeWebStore-£ X G Sign in—GoJ
[

c [ﬂ chrome.google.com/webstore/category/extensions ]

~ chrome web store

flashlabel
flashlabel extension

2. Add FlashLabel Extension to Chrome.

& chrome web store &

Home > Extensions > FlashLabel Extension

H FlashLabel Extension

J e K O | Productivity | 1users

Overview Privacy practices Reviews Related




3. Click on the FlashLabel Extension to open the setting page

and click Add.

*TF

& chrome web store

Home > Extensions > FlashLabel Extension

B Fasabe exonson

H FlashLabel Extension

kK K O | Productivty | 1users

Add FlashLabel Printer Setting Printer

“.insert printer and click Add button to enter the device list, then
Select the printer
2.0pen the file to print

3.Please do not close this web page. After closing, you
will not be able to select flashprinter.

4. After the printer is added successfully,if you close

this web page accidentally, you can reopen this web
page without adding a printer again

4, Select "Printer" (or shown as "Unknown device from Memory
Corp" ) and click on Connect (Remember to connect the printer

to your computer with the USB cable and power on).

. @MEBEQe®oc» o

T ex
“w @0

o 509




5. You are all set now, please choose Flashlabel as destination
and print the labels you need!

4 N

» Notes

1. Theres is no need to configure the printer when the
configuration notification pop-up after setting up since we
are using the extension to add printer to Chromebook;

2. Please open the extension page and keep the page
active when printing;

3. The Flashlabel Extension is developed for ChromeQS,
not for Chrome Browser in Windows or MacOS.

- /




BLUETOOTH INSTALLATION

Notice: This section is specific to model J500BT equipped with a Bluetooth
module and does not pertain to model J500 without the Bluetooth module.

> 1. Please search and download "FlashLabel" from App Store or Google Play.

< search
FlashLabel
S yiamen Angyin Information
r Technology Co, Ltd
@@ i)
amaTGs ace caTeGORY
37 a+ 8
ek iy Years Old Stilities Xian
What's New Version History
Version 135 3wago
Fix known bugs
Preview

<« Q

=  FlashLabel
Xiamen angyin Information
Technology Co., Ltd

500+
Downloads Rated for 3+ ®

Install

About this app >

Flashlabel (APP) is a professional label
printing software

Tools

Ratings and reviews @
d (0] [m]

Android

» Note

- Android phones need to use version Android 9.0 or above.
- For some Android devices, granting location permission is necessary to use
the app because Bluetooth is considered a part of the location permission. It
doesn't actually need the user's location information to run.




> 7. Open "FlashLabel" to run the app
and click "Allow" if the app asked
for Bluetooth permission.

> 3. Connect Bluetooth from the App to

pair the printer. (Notice: Be sure to
connect Bluetooth only from the APP,
not from the Android/iOS system

Bluetooth Settings.)
10:58 9 10:56 ¢ T
<o e
FlashLabel < Connect device
Connectable devices
J500-DIBSEA-LE 3
“FlashLabel” Would Like to
Use Bluetooth
This app needs to ac 3
Blue th
FlashL:
o ot
Do you all
Bluetooth permission?
Don't Allow Allow
lick to find
6 B8
nnnnnn soung

When connecting to the printer via Bluetooth, Android
users may be required to input a PIN code. If prompted,

try using "0000" (or "1234") as the code.

>4 Load the file that you want to print (PDFs, photos, and customized labels can

be printed).



> Each time you load the printer with another label size, run the
intelligent label study to let the printer learn the label size
before printting.

> To skip a label, one-click the Feed Button while the printer is on
standby. .

> To print a technical test page, press and hold the feeder button
until you hear two short beeps. The technical page helps you
determine if the printer is working properly.

> Avoid poor quality labels as they may damage the printer.
> Regularly clean the printer head.

> If label is jammed, turn off the printer, unplug the power cable,
and allow the printer head to cool down. Open the cover and
ensure that the rubber is clean. If dirty, use alcohol wipe to
clean the head. Allow the area to dry off before turning the
printer on.

> Connect the printer to the same USB port on your computer

every time. This will avoid creating duplicate copies of the
printer in your operating system.



Printing Preferences \

This section helps Windows and Mac users effortlessly
locate the configuration options for customizing the page
size, print speed, and density (darkness) of labels.

For Mac:

Open the Print dialog box by
selecting File > Print, to access
the Darkness and Speed
options, you need to switch
from "Preview" option to "Printer
Features'

» Tips:

If the printed content is not centered enough, the
Horizontal and Vertical options can be adjusted to shift
the printed content accordingly.

For Windows:

Go to the "Control Panel" (or
“Settings” ) find "Printersand =~ | e

Devices", right click on "Jiose — i
J500"(or other model) , select = = |-
"Printing preferences " > "Page | _ o

Setup". :

—_ 29 —



Method
Resolution

Max Printing Speed
Paper Width

Paper Thickness
Power Adapter
Pinting Life
Connection

Weight

Dimensions

Supported System

Operating
Environment

Storage
Environnent

Direct Thermal

203 dpi, 8 dots/mm

180 mm/s (7 inch/s)

40~110 mm (1.57"~4.3")
0.06~0.254 mm

DC 24V/2A

TPH 100 KM

USB (Optional with Bluetooth)
1.59 Ibs / 0.72 kg

176x 110x 93mm (L*W*H)

Windows/Mac OS (Print via USB cable)
iOS/Android (Print via Bluetooth)

Temperature: 0 to 45°C
Humidity: 10% ~ 80%

Temperature:-10 to 50°C
Humidity: 10% ~ 90% (Non condensing)



MAINTENANCE \

Printer Head Cleaning Steps:

1. Make sure to turn off the printer and unplug the power cable.

2. Open the cover, wait until the printer head cools down. It can be
very hot after printing.

3. Use an alcohol swap (not water) to completely clean the printer
head.

4. Wait until the alcohol has completely vaporized, then close the
cover.

5, Connect the power cable and print a test page to check if it is
clean.

SAFETY NOTICES \

1. The printer head can become very hot after printing labels. Do
not touch the printer head.

2. Do not bend the power cable excessively or place objects on
the cable.

3. Do not use the printer if you find any irregularities as these
could result in fire or electrocution.

4. Use only approved accessories and do not try to disassemble or
repair the unit by yourself.

5. Keep the printer away from water and other objects that could
penetrate the components.

6. Please unplug the printer when it is not in use for long periods
of time.



> Q1: Why does the printer print blank labels?

Answer: There may be several reasons for printing blank pages, please
check step by step:

(1) The most common reason is that the labels are loaded upside down,
especially for beginners for a thermal printer. When inserting labels into
the printer, make sure the printable side is facing the upper side.
(2)Ensure that the type of your labels in use is "Direct Thermal” Another
label type called "Thermal Transfer" can not be used on a direct thermal
printer, although they may appear similar.

(3) Check that the printer lid is closed tight.

(4) If the above steps didn't help. Please run the "Intelligent Label
Study" process. This helps if the printer is skipping blank labels.

> Q2: When the printing is not sharp or dark enough, how to
adjust the density and printing speed?

Answer: Try to adjust your printing speed or increasing the darkness
setting will result in a darker print. (If the printing speed is set too high,
and darkness too low, labels may come out faint.)

For Windows: go to "Printer Preferences" to open the dialog, and lower
the speed or increase the darkness.

For Mac: go to File > Print, to access the Darkness and Speed options,
you need to switch from "Preview" to "Printer Features".

Note: The most common reason for low-quality prints is due to the
low-quality source file. For example, if your original label file was
designed for an 8.5"x11" size printer and you printed the label by manually
taking a screenshot with low resolution, the resulting labels would have
poor quality. In this case, we recommend obtaining a higher-quality
source file instead of relying on screenshots. Alternatively, please contact
our customer service, and we will provide appropriate advice based on
your situation.



> Q3: How to crop a full size 8.5" x 11" page to a 4" x 6" label?

Answer: Two suggestions could help you print the 4"x6" label:

(1) Set the format to 4"x6" in the background of the platforms and
regenerate the PDF before printing. Platforms, including Etsy, UPS,
and others, may send you an 8.5"x11" label by default when you
purchase a shipping label, you may need to change the default format
to 4"x6" before purchasing.

(2) Use the snapshot function of Adobe Acrobat Reader software
(which is free) to cut and print the label to 4"x6" if you already get an
8.5"x11" label in pdf format.

> Q4: Printer is skipping labels or continuously feeding?

Answer: There are two main reasons why this is happening:

(1) The printer has not yet learned the size of your label (most common).
To fix this, manually run the "Intelligent Label Study" process (refer to
page 07).

(2) The selected page size in the printer driver or your printing software
does not match the actual label size in use. The printer is designed to
accommodate small errors (about 2mm), but if the selected paper size
is too large or too small, skipping labels is possible. Please check if you
have selected the correct label size before clicking Print.

For Windows, go to "Printer Preferences" -> "Page Setup" and adjust
the label size to match the actual label size. Or select the page size from
the Print dialog directly, the default value is typically 4x6 inches.

For Mac, you can change the label size during the printing interface
when printing labels.

Note: The software you used to print (e.g. Chrome Browser) labels can
override the driver's default label size setting and send the printjob in a
larger / smaller size to the printer. Remember to select the right label
size before printing with your software.



SUPPORT AND WARRANTY \

Your Jiose printer is covered by a one-year warranty.

You're welcome to visit our website: www.jioseprinter.com

to get the live support, latest driver, platform setup guide and
FAQs.

@ Jiose Email: support@jioseprinter.com
LiveChat: www.jioseprinter.com (Recommend)

. Jiose Tel: +1 281-236-7202

Service Hours: Weekdays from 9:00am to 18:00pm PST.

Scan QR Code below to CONTACT Jiose TECH SUPPORT
Directly or email support@jioseprinter.com

Website

Jiose J500BT v4.02
— 34—



